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Preface

This User Guide has been implemented by Boot &Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and get
a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience

This User Guide is intended for the following audience:

● Persons in charge of introducing automation devices.

● Persons who design automation systems.

● Persons who install or connect automation devices.

● Persons who manage working automation installation.

Warnings:

● It must be used a long micro USB-B type cable with the plastic part thin (contour of

2mm).

● Unused pins should not be connected. Ignoring the directive may damage the

controller.

● Improper use of this product may severely damage the controller.

● Refer to the controller’s User Guide regarding wiring considerations.
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● Before using this product, it is the responsibility of the user to read the product’s User

Guide and all accompanying documentation.

● Maintenance must be performed by qualified personnel familiarised with the

construction, operation, and hazards involved with the control.

● Maintenance should be performed with the control out of operation and disconnected

from all sources of power.

● Care should be taken when servicing electrostatic sensitive components. The

manufacturer's recommendations for these components should be followed.

● The ESP32 14 PLCs are Open Type Controllers. It is required that you install the ESP32

14 PLC in a housing, cabinet, or electric control room. Entry to the housing, cabinet, or

electric control room should be limited to authorised personnel. Failure to follow these

installation requirements could result in severe personal injury and/or property

damage. Always follow these requirements when ESP32 14 PLCs.

● In case of installation or maintenance of the ESP32 14 please follow the instructions

marked in the Installation and Maintenance section.

● Do not disconnect equipment when a flammable or combustible atmosphere is

present. Disconnection of equipment when a flammable or combustible atmosphere is

present may cause a fire or explosion which could result in death, serious injury and/or

property damage.

Avertissements:

Il faut utiliser un long câble de type micro USB-B avec la partie plastique fine (contour

de 2mm).

Les broches non utilisées ne doivent pas être connectées. Ignorer la directive peut

endommager le contrôleur.

Une utilisation incorrecte de ce produit peut endommager gravement le contrôleur.

Reportez-vous au Guide de l’utilisateur du contrôleur pour les considérations de

câblage.

Avant d’utiliser ce produit, il incombe à l’utilisateur de lire le Guide de l’utilisateur du

produit et la documentation qui l’accompagne.

La maintenance doit être effectuée par personnel qualifié familiarisé avec la

fabrication, le fonctionnement et les dangers liés au contrôleur.
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La maintenance doit être effectuée avec l’équipement hors service et déconnectée de

toutes les sources d'alimentation.

Faites attention lors de l'entretien des composants sensibles à l'électricité statique. Les

recommandations du fabricant pour ces composants doivent être suivies.

Les automates de la famille ESP32 14 sont des contrôleurs de type ouvert. Il est

nécessaire d'installer l'automate ESP32 14 dans un boîtier, une armoire ou une salle de

contrôle électrique. L'accès au boîtier, à l'armoire ou à la salle de commande

électrique doit être limité au personnel autorisé. Le non-respect de ces exigences

d'installation peut entraîner des blessures graves et/ou des dommages matériels

importants. Respectez toujours ces exigences lors de l'installation des automates de la

famille ESP32 14.

En cas d'installation ou de maintenance du ESP32 14, veuillez suivre les instructions

indiquées dans la section Installation et Maintenance.

Ne débranchez pas l'équipement en présence d'une atmosphère inflammable ou

combustible. La déconnexion de l'équipement en présence d'une atmosphère

inflammable ou combustible peut provoquer un incendie ou une explosion pouvant

entraîner la mort, des blessures graves et/ou des dommages matériels.

Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration
THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE
OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.
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The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

● Systems, machines, and equipment that could present a risk to life or property.
● Nuclear energy control systems, combustion systems, railroad systems,

aviation systems, medical equipment, amusement machines, vehicles, safety
equipment, and installation subject to separate industry or government
regulations.

● Outdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Intended use or of Industrial Shields products
Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct
manner. It must respect the permissible ambient conditions. You should also follow the
indications and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers
Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.
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Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.

Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or establish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: − Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
− Response times of the controller and drive − Operating and/or ambient conditions not
within the scope of the specification − Condensation / conductive contamination −
Parameterization, programming, cabling, and installation errors − Use of radio devices /
cellular phones in the immediate vicinity of the controller − External influences /
damage.
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2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: − Component malfunctions − Software errors − Operating and/or
ambient conditions not within the scope of the specification − External
influences / damage.

3. Hazardous shock voltages caused by, for example: − Component malfunctions −
Influence of electrostatic charging − Induction of voltages in moving motors − Operating
and/or ambient conditions not within the scope of the specification − Condensation /
conductive contamination − External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions because of improper operation of
the system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability
Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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1. ESP32 14 Module: General Features

COMPACT ESP32 PLC 14 MODULE PLC

Input Voltage 12 to 24Vdc
Fuse protection (2.5A)
Polarity protection

Input rated voltage 24Vdc

Rated Power 30W

I Max. 1,5A

Size 100x45x115

Clock Speed External: 240 MHz Internal: 8 MHz

External Flash Memory 4MB

SRAM 4 MB

PSRAM 2 MB

Communications USB - RS485 - I2C - ETH - WiFi -
BLE MAX487CSA - W5500

An/Dig Input 12 bit
*(see Section 9.2)

0 - 10Vdc
OR

5– 24Vdc
OR

4-20mA

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vac

OR
5 to 24Vdc

I min: 2 to 12mA
Rated Voltage: 24 Vdc

OR
4 to 20mA

*Check Section 10 for
digital inputs threshold

detection

Digital Input 10 bit
3,3 – 24Vdc

3.3 to 24Vdc
Freq: 10 Hz

Input Impedance: 27K
Separated PCB ground

I min: 2 to 12mA
Opto-isolation

Rated Voltage: 24 Vdc

Relay Output

30Vdc / 250Vac
Galvanic Isolation

Diode protected for Relay Imax: 3A (30Vdc)
Imax: 5A (250Vac)

Digital Isolated Output

5 to 24Vdc
I max: 70 mA

Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410 mA

Expandability USB - RS485 - I2C - ETH - WiFi -
BLE

Reference IS. 013000000001
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1.1 Power consumption of the 14 IOs PLC

Current resting
(mA)

Power resting
(W)

Current active
(mA)

Power active
(W)

42 1,008 81 1,944

The power consumption is measured at 24Vdc.

The current resting column denotes the minimum current drawn by the PLC when all outputs
are at a LOW level, representing the PLC's baseline power consumption.

In contrast, the current active column reflects the current drawn by the PLC when all outputs
are at a HIGH level, and there are no connections to any of the outputs. While this value is not
the absolute maximum the ESP32 based PLC can draw, it serves as a reference point for
expected current values.

It's important to note that the practical maximum current may vary depending on the type of
actuators connected to the outputs and the number of I/Os used. The actual consumption can
be influenced by the specific configuration and load connected to the PLC's outputs."
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2. Technical Specifications

2.1 General Specifications:

Power supply
voltage DC power supply 12 to 24Vdc

Operating
voltage range DC power supply 11.4 to 25.4Vdc

Power
consumption DC power supply 30W max.

External
power supply

Power supply voltage 24Vdc

Power supply output
capacity 300mA

Insulation resistance 20MΩ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength 2.300Vac at 50/ 60 Hz for one minute with a leakage current of 10mA max.
Between all the external AC terminals and the protective earth terminal.

Shock resistance 80m/s2 in the X, Y and Z direction 2 times each.

Ambient temperature (operating) 0º to 60ºC

Ambient humidity (operating) 10% to 90% (no condensation)

Ambient environment (operating) With no corrosive gas

Ambient temperature (storage) -20º to 60ºC

Power supply holding time 2ms min.

Weight 350g max.
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2.2 Performance Specification:

Board ESP32 DevKit C (3.3V)

Control method Stored program method

I/O control method Combination of the cyclic scan and immediate refresh processing methods.

Programming language
Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ESP32

External Flash Memory 4MB

Program capacity (SRAM) 4MB

PSRAM 2MB

Clock Speed 8MHz

2.3 14 IOs Pinout

IOs Table

Model Reference
Analog Input (4-20 mA /

0-10V) *
Digital Isolated

Input
Digital Isolated

Output Relay Output

14 IOs 013000000001 2 7 4 1

* The analog inputs can also be used as digital inputs.

NOTE: consider that depending on your selection when acquiring the PLC, the model you use

will have either two analog inputs of 0-10Vdc or 4-20mA, but both cannot coexist in the same

PLC, nor be modified by software.
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2.4 Symbology

Table that includes all the symbology that is used in the serigraph of the ESP32 PLC 14 Module:

Symbol Standard No. /
Standard Title

Standard
Reference No. /
Symbol Title

Symbol Meaning

IEC 60417 /
Graphical symbols

for use on
equipment

5031 / Direct
Current

Indicates that the equipment is
suitable for direct current only;
to identify relevant terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5032 / Alternating
Current

Indicates that the equipment is
suitable for alternating current

only; to identify relevant
terminals

IEC 60417 /
Graphical symbols

for use on
equipment

5130 / Pulse
General

To identify the control by which
a pulse is started.

IEC 60417 /
Graphical symbols

for use on
equipment

5017 / Earth,
Ground

To identify an earth (ground)
terminal in cases where

neither the symbol 5018 nor
5019 is explicitly required.

IEC 60417 /
Graphical symbols

for use on
equipment

5115 / SIgnal lamp

To identify the switch by
means of which the signal

lamp(s) is (are) switched on or
off.

Medical Devices
Directive
93/42/EEC

CE Marking

CE marking indicates that a
product complies with

applicable European Union
regulations

ISO 7000/
Graphical symbols

for use on
equipment

0434B /
Warning symbol

Indicates a potentially
hazardous situation which, if
not avoided, could result in
death or serious injury

ISO 7000/
Graphical symbols

for use on
equipment

5036 / Dangerous
Voltage

To indicate hazards arising
from dangerous voltages
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3. Precautions

Read this manual before attempting to use the ESP32 14 PLC and follow its descriptions for
reference during operation.

3.1 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.2 General Precautions

The user must operate ESP32 14 Module according to the performance specifications

described in this manual.

Before using ESP32 14 PLC under different conditions from what has been specified in this

manual or integrating ESP32 14 Module to nuclear control systems, railroad systems, aviation

systems, vehicles, combustion systems, medical equipment, amusement machines, safety

equipment and other systems, machines, and equipment that may have a serious influence on

lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure

that the rating and performance characteristics of ESP32 14 Module are sufficient for the

systems, machines, and equipment, and be sure to provide the systems, machines, and

equipment double safety mechanisms. This manual provides information for programming and

operating the ESP32 14 Module.
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C

language. They can also be programmed directly using C but it is much easier working with

Arduino IDE as it provides lots of libraries that help in the programming.

Furthermore, Industrial Shields provide boards for programming the PLCs much easier.

Basically, it is not needed to define the pins and if those pins are inputs or outputs. Everything

is set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.

Requirements:

Arduino IDE 1.8.19 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

2. In Additional Boards URLs write the following:

http://apps.industrialshields.com/main/arduino/boards/package_industrialshields_index.json

If you already have an URL inserted, input an “,” between both URLs.

3. Press OK to save the changes.
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4. Go to: Tools -> Board: … -> Boards Manager

5. Search for industrialshields-esp32.

6. Click install industrialshields-esp32 (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:
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Once it is selected the 14 IOs PLC in Industrial Shields ESP32, an extra option will appear on

“Tools”:

There, it is possible to select the mode used for the ESP32 PLC 14. In this case 14 IOs PLC (4-20

mA).

Also, there are some examples of programming in File -> Examples -> ESP32 14 PLC Family.

Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/

18
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5. How to connect 14 IOs to PC

- Connect USB port from PLC to PC.

NOTE:
ESP32 14 PLC uses a long micro USB
cable.

- Open Arduino IDE interface:
- Select the correct board.
- Select the correct port.
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6. How to connect PLC to power supply

- ESP32 14 PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!

- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

- Suggested power suppliers

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC

61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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7. Block diagram
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8. ESP32 14 serigraphy

14 IOs
Connector

ESP32
Pin

Function

A+
B-
SCL
SDA
GND
5V
GND
GND

AI0.1/I0.8
AI0.0/I0.7

I0.6
I0.5
I0.4
I0.3
I0.2
I0.1
I0.0
GND

A+
B-

SCL
SDA
GND
5V

GND
GND

G33/G35
G32/G34

GPA5
GPA6
GPA4
GPB5
GPB4
GPB2
GPB3
GND

RS485
RS485

I2C
I2C

GND
-

GND
GND

Analog/Digital Input
Analog/Digital Input

Digital Input
Digital Input
Digital Input
Digital Input
Digital Input
Digital Input
Digital Input

GND

22

14 IOs
Connector

ESP32
Pin

Function

REL-B
REL-A
GND
GND
Q0.3
Q0.2
Q0.1
Q0.0
Vdc
GND

CON2
CON1
GND
GND
G27
G26
G25
G12

-
GND

Relay
Relay
GND
GND

Digital Output
Digital Output
Digital Output
Digital Output
Power Supply

GND
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NOTE: In case you need to activate the reset button, it can be found by opening the top cover

and accessing the white reset button of the ESP32 board integrated inside the enclosure.

NOTE: The LEDs positioned at the top of the PLC, which go from led 0 to 8 refer to both inputs

and outputs.

For example, if you are using input I0.4, LED 4 on the top cover of the PLC will indicate the

signal status of this input.

If output Q0.0 is being used, LED 0 on the upper cover of the PLC will indicate the status of the

signal of this output.

An input and an output with the same nomenclature can never work at the same time.
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9. Pinout Response

9.1 Digital Inputs

Average (μs) Max time (μs)

Digital input 455 660

9.2 Analog Inputs

As a Average (μs) Max time (μs)

Digital input 1 23

Analog input (4-20mA) 94 524

Analog input (0-10V) 90 517

9.3 Digital Outputs

Output frequency Period Delay Duty cycle

19,53 kHz 51 μs 25 μs 82,23 %

333,3 Hz 3 ms 1,5 ms 50 %

Rise time Fall time

15,40 ns 5,36 μs
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10. Software set up

Whether they are digital, analog or relay, the inputs and outputs must be configured in the set

up part of the code, like it is usually done in common Arduino boards. The function that must

be used is pinMode(), like it is explained on the official Arduino website:

https://www.arduino.cc/reference/en/language/functions/digital-io/pinmode/

Check sections 4 and 5 to configure the software interface and to connect the ESP32 PLC 14 to

the PC.

Before programming the ESP32 PLC 14 is required to connect it to the power supply. Check

section 6 for more information.

10.1 Digital Input

To configure a digital input, it can be done this way:

pinMode(I0_0, INPUT);

The available digital input pins are defined between I0_0 and I0_6. Here is an implementation

example:

*Pins I0_7 and I0_8 can also be used as digital.

25
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10.2 Analog Input

To configure an analog input, it can be done this way:

pinMode(I0_7, INPUT);

The available analog input pins are defined as I0_7 and I0_8. Here is an implementation

example:

*Note: Consider that depending on your selection when acquiring the PLC, the model you use

will have either two analog inputs of 0-10Vdc or 4-20mA, but both cannot coexist in the same

PLC, nor be modified by software.
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*Note: The analog inputs have a resolution of 11.507 bits counting from 0 to 10Vdc. The first

0.5V (0-0.5Vdc -> 0 - 222) range is not detected. The remaining range is offset by approximately

-171, starting at V< 0.5 -> 0.

This issue stemming from the ESP32 GPIOs is corrected automatically by the analogRead()

function on ESP32 PLC 14. This is internally done by multiplying (value+171)*1.295 when the

value is non-zero. This corrects the bit resolution and offset, but the range between 0-0.5V still

can not be detected since there is no data to work with.
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10.3 Digital Output

To configure a digital output, it can be done this way:

pinMode(Q0_0, OUTPUT);

The available digital output pins are defined between Q0_0 and Q0_3. Here is an

implementation example:
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10.4 Relay Output

To configure the relay, it can be done this way:

pinMode(R0_0, OUTPUT);

The available relay output is defined as R0_0. Here is an implementation example:

11. Digital inputs threshold detection

The ESP32 PLC 14 inputs have a minimum voltage threshold to reliably detect the signal when

used as digital input. The threshold value is different depending on the input type:

29

Input type Threshold voltage (V)
Digital input 4.1

Analog input (0-10V mode) 6.5
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12. I/Os Communications

12.1 RS485

The RS-485 is a half-duplex serial communication. The ESP32 14 PLC uses the MAX841CSA for

the RS-485 communication. In the following image you can see the internal schematic of the

PLC of the connection between microcontroller pins, the RS-485 chip and its outputs.

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

The RS-485 communication interface of the PLC supports both master and slave functionalities

for the Modbus RTU protocol. The integration can be achieved by using our Modbus library.

12.2 I2C

The I2C protocol is meant to work in a pull-up configuration. A pull-up configuration means

that when the pin is at rest (nothing connected to it) it always reads a HIGH value. In this case it

reads 5V when nothing is connected. The pull-up configuration is established by default in

these pins.

The I2C communication can be achieved by using the Wire library from Arduino. Additionally,

the Arduino IDE offers some examples under “File > Examples > Wire” such as “WireScan.ino”

to scan the available I2C addresses.
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12.3 Ethernet

ESP32 14 Ethernet port controller is based on w5500 IC, which is the IC compatible with

Arduino Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the

ESP32 14. In the ESP32 14 PLC, W5500 IC communicates to the microcontroller board via SPI

bus.

The Ethernet interface of the PLC supports both master and slave functionalities for the

Modbus TCP protocol. The integration can be achieved by using our Modbus library.

12.4 WiFi & BLE

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
IoT Sensor Hub, Generic Low-power IoT Data Loggers and Mesh Network.
It is designed for Internet-of-Things (IoT) applications.

12.4.1 General Specifications

Wi-Fi
● 802.11 b/g/n 
● 802.11 n (2.4 GHz), up to 150 Mbps

Bluetooth

● Bluetooth 4.2 BR/EDR BLE dual mode controller
● +12 dBm transmitting power
● NZIF receiver with -97 dBm BLE sensitivity
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13. Additional features: Expansion Modules

13.1 LoRa

The LoRa expansion board can use the RN2483 or RN2903 microchip depending on the

frequency needed, which have the following features:

● Model: RN2483 (for Europe/Asia), RN2903 (for North America/Australia)

● Type: LoRa

● Key Features: On-board LoRaWAN protocol stack, ASCII command interface over UART,

Castellated SMT pads for easy and reliable PCB mounting, Environmentally friendly,

RoHS compliant, Device Firmware Upgrade (DFU) over UART, etc.

● Applications: Automated Meter Reading, Home and Building Automation, Wireless

Alarm and Security System, Industrial Monitoring and Control, Machine to Machine

(M2M), Internet of Things (IoT), etc.

13.2 CAN

The CAN expansion board uses the MCP2515 microchip, which has the following features:

● Model: MCP2515

● Type: CAN V2.0B

● Key Features: Speed of 1Mb/s, receive buffers, masks and filters, data byte filtering on

the first two data bytes, three transmit buffers with prioritization and abort features,

high speed SPI interface (10MHz), etc.

● Applications: Communication with all kinds of CAN devices and the protocols that can

be applied to this communication method.

13.3 LTE/NBIoT

The LTE/NBIoT expansion board uses the SARA-R412M module, which has the following

features:

● Model: SARA-R412M

● Type: LTE-M / NB-IoT / EGPRS

● Key Features: LTE Cat M1/NB1, and EGPRS module with multi-regional coverage, low

power consumption, high precision, ideal for mission-critical IoT solutions, ensures

data integrity, over-the-air firmware updates, and more.

● Applications: Remote monitoring automation, asset tracking, surveillance and security,

home automation systems, point of sales terminals etc.
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14. Typical Connections
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15. Connector details

For I/O and power supply there is a 15EDGK-3.81-02P-14-00A(H) connector from DEGSON

ELECTRONICS. 15EDGK-3.81-02P-14-00A(H)

For communication pinout there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix

contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference 15EDGK-3.81-02P-14-00A(H)

Pitch 3,81mm

Depth 15,5mm

Width 11,2mm

Length 8,41mm

Current Rating

Voltage Rating

8A

125V

Article reference FK-MC 0,5/10-ST-2,5

Rigid conduit section min. 0,14 mm²

Rigid conduit section max. 0,5 mm²

Flexible conduit section min. 0,14 mm²

Flexible conduit section max. 0,5 mm²

Conduit section AWG/kcmil min. 26

Conduit section AWG/kcmil max. 20
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16. ESP32 14 Dimensions:

45mm width

- DIN rail mounting:
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17.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the I/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ESP32 14 MODULE from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
ESP32 14 Module. When configuring the layout of the ESP32 14 Module inside your panel,
consider the heat-generating devices and locate the electronic-type devices in the cooler
areas of your cabinet. Reducing the exposure to a high-temperature environment will
extend the operating life of any electronic device. Also consider the routing of the wiring
for the devices in the electric cabinet. Avoid placing low-voltage signal wires and
communications cables in the same tray with AC power wiring and high energy, rapidly
switched DC wiring.

Provide adequate clearance for cooling and wiring ESP32 14 Module. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above
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and below the devices. Also, allow at least 25 cm of depth between the front of the modules
and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.
Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.
- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
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and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.
- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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18. Revision Table

Revision Number Date Changes

0 11/12/23 First Implementation

1 13/03/24 Second Implementation

2 20/03/24 Updated Analog Input chapter
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About Industrial Shields:

Direction: Camí del Grau, 25

Zip/Postal Code: 08272

City: Sant Fruitós de Bages (Barcelona)

Country: Spain
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Telephone: (+34) 938 760 191

Mail: support@industrialshields.com
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